
PleasantValleyPress.net Manuscript Submission Requirements 
 

Copyright 2010 PleasantValley Press.net  1 
 

Since PleasantValleyPress.net is a small and fairly new business, we can keep costs low and decrease the 
time and work required by establishing standards for manuscripts that are submitted for review, editing, 
interior design, and/or publishing. 

Authors whose manuscripts are not in compliance with these guidelines will incur costs beyond the 
quoted price. The additional costs will depend on the amount of time required to produce a compliant 
manuscript. These guidelines are based almost entirely on our printer's submission requirements, the 
Chicago Manual of Style manuscript preparation chapter, and other resources. 

We recommend that you ignore many of the requirements in your first drafts, as worrying about them 
during the creative process is unnecessary. Just write. However, when you start editing, you will save an 
enormous amount of time (and possibly money) by checking for and correcting hidden formatting as you 
go. If you prefer, you can wait and do it after your final edit, but it can take a great deal of extra time. 
Balance the ‘time cost’ between doing it as you go and doing an entire read-through just make sure your 
manuscript compliant with the requirements in this document. 

FILE NAME 
Please include your first initial and last name, along with an abbreviated title. For example, for this 
document, I might use: SCarney-SubmissionGuide.docx 

NOT A WORD PROCESSING ‘EXPERT?’ 
A few of the requirements are quite simple and will not require any particular expertise on your part:  
almost everyone can understand that manuscripts should have a one-inch margin all around and should 
be on plain white paper.  

However, many others will require that you get to know your word processing software better. If you are 
working in MS Word, there are many resources available to you, including free hands-on tutorials 
available on the Microsoft Office Web site. If you prefer, there are any number of books that will provide 
the help and information you need to bring your skills up to speed.  I have used the Dummies and ... for 
Idiots books for a lot of software and other learning in the past and particularly like them because they are 
intended specifically for people who are trying to learn something new and unfamiliar: they assume we 
don't understand the ‘tech speak’ that is found in software and other manuals. The explanations are easy 
to understand and any exercises are easy to follow. 

Another source that many forget about is the Help files in most programs. Some of them are a bit more 
technical, but the MS Word Help files are easily understood by anyone with the patience to read and 
understand them. 

I will, as time permits, add some simple tutorials on this site for the functions I believe are most 
important. Send me an email if you'd like to be notified when new cheat sheets are available (at no cost, of 
course). 

PRODUCING A CLEAN MANUSCRIPT 
No matter how you intend to publish your book, a clean manuscript is important for a variety of reasons. 
If you will be sending it to agents or traditional publishers, first impressions are extremely important. If a 
manuscript is messy, poorly set up, and doesn't meet their—or industry—guidelines, they might reject it 
without reading the first page. They get hundreds of submissions and your poorly produced manuscript 
marks you as a beginner who is unaware of ‘the rules of the road.’ 

If you plan to self-publish using a print-on-demand (POD, pronounced P-O-D, not pod) publisher, you 
might be required to submit your properly formatted manuscript or, in many cases, an Adobe Acrobat 
PDF file that is ready to be sent directly to the printer. They might be able and willing to handle this for 
you, but it could add a great deal to the cost of getting your book published, perhaps even a few hundred 
dollars. 

If you decide to do it all on your own and send a poorly formatted manuscripts to a printer, it will look like 
it was produced by an amateur, and potential buyers might assume that the content is as amateurish as 
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the formatting. In addition, the cost of printing could be higher because the hidden formatting can add 
pages to your book. Printing charges may include a per book PLUS a per page charge. 

So it is well worth your time, effort, and the cost of a decent book or two to learn what you need to do to 
succeed—or at least produce a manuscript that looks professional. Your readers will decide whether what 
you've written is worth the price, and they'll tell their friends! 

HIDDEN FORMATTING 
In Microsoft Word and most other word processing programs, you can view the hidden formatting 
elements by finding and turning on the Show All function (MS Word; other programs might call it 
something else). Activating this function allows you to see the spacing, tabs, and other items that aren't 
otherwise visible. To see what hidden formatting looks like when the function is on, click on the Show All 
button (Home tab in Word 2007, in the Paragraph section; see illustration below). 

To see what the formatting marks look like if you haven't used this function before, begin by 
clicking on the Office button in the top left corner of the screen. Click on the Word Options button on 
the bottom right, then click on Display to see this screen. 

 

It is not necessary to click all the items you want to display. There's an easier way to turn the display on 
and off as you work. Opening this screen simply lets you see what the format marks look like. 

 

Make sure you're on the Home tab, then click on the paragraph mark to ‘show all.’ Click again to hide it. 

To avoid having to constantly return to the Home tab, you can add the Show All button to the Quick 
Access toolbar: Click on the Office button and Word Options, as you did before, and select Customize 
on the left. In the dropdown list (under Choose commands from), select Home Tab. Scroll down to 
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Show All, click on it, then click on the Add >> button to add it to the toolbar at the top of the screen 
next to the Office button. 

 

 

 

When you begin editing, turn on Show All and make a habit of cleaning up the formatting as you edit. It 
will be a bit of a pain at first, but you'll soon get used to it and it is worthwhile. Now we're ready to get to 
work. 

The Hard & Fast Formatting Rules: 
• Only one space between words. No exceptions. 
• Only one space between sentences. No exceptions. 
• NEVER use the space key to indent paragraphs. The easiest way to create a consistent indent is 

to add the amount you want in the Paragraph setting in the Normal style, and select “This 
document only” so it doesn't interfere with non-manuscript writing. (Check back for a tutorial on 
creating and using style sheets in MS Word to ensure that your formatting is consistent and 
greatly reduce the amount of work necessary to accomplish that). 

• DO NOT use the Enter key at the end of lines of text in the same paragraph. The software will 
automatically wrap the text. Only press Enter to start a new paragraph. 

• DO NOT use a soft return (Shift + Enter) at the end of sentences or paragraphs. It will cause 
weird and ugly breaks in the middle of sentences.  

• DO NOT use the Tab key to indent the first line of paragraphs. Use the Help files in your 
program to learn to set an automatic (and consistent) first line indent, if you don't already know 
how to do it. 

• Delete extra spaces between the end of the paragraph (the last punctuation mark) and the 
paragraph symbol. 

When you see violations of the above rules, simply delete them. If you are unwilling or unable to produce 
a clean manuscript, extra charges could be as high as $1.00 US per page for PleasantValleyPress.net to do 
it for you. If you choose to leave it ‘as is,’ your printed book will look sloppy and amateurish—self-
published in the worst sense of the word. PleasantValleyPress.net will request that you sign a waiver and 
not hold the company liable for any extra expenses incurred for reformatting and reprinting if you decide 
to leave in all the extraneous hidden formatting. 
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General Manuscript Format—PleasantValleyPress.net 
• All manuscripts submitted for review, editing, and/or interior formatting must be on plain white 

paper (real or virtual) in Portrait orientation, with page numbers in the footer of each page and 
the chapter title on the first page of each new chapter. 

• Set up an automatic first-line indent of 0.4″ 

• Set the line spacing to 1.5 or double spaced. Notify us if you need instructions. Only hit Enter 
twice when you want a break between two sections in the same chapter—for example, when there 
is a new subject, a time lapse between the previous and next section within the same chapter, etc. 

• (Optional) We prefer that you not use single quotes where an apostrophe is required. They are 
two entirely different punctuation marks. It can be a bit of a pain, but will look much more 
professional. Here's how I make it as easy as possible. (I try to do it while I'm writing, but it's easy 
to overlook it, so I double check when I'm editing.) 

o To insert an apostrophe, click on the Insert tab, then on the Symbol button in the 
Symbols section on the right side of the tool bar. Set the font to whatever you're currently 
using, then scroll through the symbols until you find a symbol that looks like this: ' It's 
very different from a single quotation, which looks like this: ’ 

o Click the Insert  button to insert the symbol where the cursor is located. 

Tedious, huh? Here's how I solve that problem. 
o Once I've inserted the first one and made sure it's in the correct font, I simply highlight it 

and copy it by pressing Ctrl+C. 
o To paste it, I only have to click where I want it and press Ctrl+V to insert it 

NOTE: I have occasionally been known to cut or copy and paste a paragraph or chapter between 
apostrophes. When I go to paste an apostrophe, I might get pages of copied text instead. Instead 
of panicking, simply press Ctrl+Z to undo it. 

The MS Word clipboard can hold a number of cut or copied items. If you have the Clipboard open,  
just click on the one you want to insert. On the Home tab in Word 2000, the first group on the 
left side of the Taskbar should be the Clipboard (with the Paste, Cut, Copy, and Format Painter 
options). At the bottom of the group, you'll see the word “Clipboard” with a tiny down arrow to 
the right. Click on the arrow to open the Clipboard on the left side of the screen. If you use the 
clipboard a lot, click on the Options button at the bottom and select the options that suit you (you 
can change them whenever you want to). 

USE YOUR SPELLCHECKER and—when required—a dictionary. I use the dictionary when I have 
used a word I can't adequately define in my head. Rather than hauling out the dictionary for every word 
when you're in doubt, you can simply right click on the word (in MS Word) and select Synonyms from the 
context menu. One typical and frequent error: knowing when to use ‘lay’ and when to use ‘lie.’ 

CONSISTENCY 
We strongly recommend that you start a list of character names, place names, etc., that appear in your 
manuscript and refer to your list as needed to ensure that you have spelled names and locations the same 
way every time they are used. For example, if you have a character named Marcy, make sure you don't call 
her Marcy half the time and Marcie the rest of the time! 

Rather than reading through the entire manuscript again to look for possible mistakes of this kind, just 
enter a possible variation in the Find function (Ctrl+F), enter the correct spelling in Replace, then click 
on the More... button. Select Match case (only if you typed it in with the correct capitalization in the 
Find what: field) and Find whole words only. If you're not sure what variations you may have used, 
you might want to add Sounds like (English). 
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PUNCTUATION 
• End every sentence with a punctuation mark. Usually this will be a period, although it can be a 

question mark, ellipsis, etc. 

• Use “double quotes” when you are actually quoting something. Use ‘single quotes’ when you want 
to call attention to a word or phrase, or to an unusual word or one you're using in some way other 
than its commonly understood use. 

• Punctuation such as commas, question marks, or periods almost always go inside quotation 
marks, double or single. 

MS WORD 2007 HELP 
To read about using Word templates and styles for formatting your manuscript, click on the tiny blue 
button in the upper right corner of the window (it has a white question mark inside it). When the contents 
page appears, type (without the quotation marks) “Style Basics in Word,” then click the search button to 
read a moderately long, but easy to understand, illustrated article about using styles to simplify and speed 
up formatting your work. 

If you prefer hands-on tutorials, there are lots of free ones on the Microsoft Web site 
(http://office.microsoft.com). On the Web site: 

1. Click on the Help and How-to tab at the top. 

2. On the left navigation bar under 2007 Release Learning Resources, click on 2007 Training 
Course Catalog. 

3. Select Word 2007. 

4. Under 2. Start with an outline or let Word do the work with templates and Quick 
Styles, select Format your document with styles. Then just follow the instructions. 

Also consider doing the Save time with templates tutorial. That way, once you get your manuscript 
format just the way you want it, you can save it as a template and use it over and over again.  

All the Office training courses are free (unless you're looking to be a certified Office expert!), they are fun, 
and the thirty minutes to an hour of your time will save you tons of time and hassles in the future. If you 
are preparing the interior of a book to a printer's specifications, you'll eventually need to know how to 
properly use section breaks, set up page numbers, and format headers and footers so that the page 
numbering continue throughout the manuscript, but the headers for each section are different (sections 
are something else you'll eventually need to know about if you plan on self-publishing your book. Many 
print-on-demand publishers will format your book for you, but you can sometimes save some money by 
doing it yourself.) 

FEEL FREE to contact us at PleasantValleyPress.net if you have questions. 

Sunny Carney 
PleasantValleyPress.net 


